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This section introduces you to the AvTrend user interface and discusses general information 
such as viewing spectra, managing files, and navigating among items in a file or between 
downloaded files. It also gives you specific information about reading spectra in the AvTrend 
viewer. 

 

Figure 1: Diagram of the AvTrend Bronze main window 
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AvTrend software, which you load on your PC, allows your ACES analyzer to work in 
concert with a personal computer. ACES analyzers already allow you to download data to a 
PC for storage. The AvTrend software provides enhanced printing and upload/download 
capabilities, as well as management tools that save you time and can greatly increase your 
productivity. You may also upload setups to an ACES analyzer. 

One benefit of using the AvTrend software is you can download preconfigured setups from 
the ACES Systems web site (www.acessystems.com) or some other Internet address. With 
just two clicks of your mouse, you can download these web setups and upload them directly 
to your ACES analyzer. 

AvTrend is available in two versions — Bronze and Silver — and will be available in 
customer-specific builds. The chart below shows the features available on Bronze and Silver. 

Bronze and Silver Feature Comparison 
   ACES Systems Analyzers Supported Bronze Silver 
Model 2020 ProBalancer Analyzer � � 
1700 Series Analyzer  � 
VIPER 4040 Analyzer  � 

Features 
Manage Setups � � 
Create Setups  � 
Edit Setups  � 
Manage Setup Library � � 
Export Setups/Jobs � � 
Analyze Vibration Surveys � � 
Expand/Shrink Plot Scales � � 
Change Cursor Appearance to Harmonic � � 
Annotate Peaks � � 
Alarm Notations  � 
Print to Any Windows-Supported Printer � � 
Upload IntelliTrend Database  � 
Upload Setups from Web � � 
Upload Setups from File � � 
Download AvTrend Feature Updates from Web � � 
Download/Upload Data to Model 2020 � � 
Download/Upload Data to 1700 Series Analyzer  � 
Download/Upload Data to VIPER Model 4040  � 
Examine Model 2020 Data Files � � 
View Data by Type � � 
View Data by Serial Number  � 
View Data by Date  � 
Backup and Restore Database  � 
Central Database (Microsoft Access)  � 
   
Data Storage 
Model 2020 Prop Setup/Job � � 
Model 2020 Main Rotor Setup/Job � � 
Model 2020 Tail Rotor Setup/Job � � 
Model 2020 Vibration Survey Setup/Job � � 
1700 Series Vibration Survey  � 
VIPER 4040 Prop Setup/Job  � 
VIPER 4040 Main Rotor Setup/Job  � 
VIPER 4040 Tail Rotor Setup/Job  � 
VIPER 4040 Vibration Survey Setup/Job  � 
VIPER 4040 Fan Trim Balance Setup/Job  � 
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AvTrend allows you to download data files from an ACES analyzer; view the sensors, setups, 
and jobs associated with the downloads; export sensors, setups, and jobs in various formats; 
print sensors, setups, and jobs; and upload sensors and setups to the ACES analyzer. 

NOTE 
Although you can upload sensors and setups, you cannot create the sensor data or 
setups in AvTrend Bronze. 

�������������������������� ��������� ��������� ��������� �������

Whenever you have a data file open in AvTrend, any sensors, setups, and jobs contained in 
that file appear in the Tree View Area on the left side of the AvTrend viewer. To open any 
one of those items, click on its name in the Tree View. AvTrend displays that item in the 
Data Viewing Area (right panel). 

 

Figure 2: AvTrend Tree View; no item is open in the Data Viewing Area. This example data 
file contains sensors, setups, and propeller, tail rotor, and vibration survey jobs. 

NOTE 
In the Tree View, AvTrend gives you access to menu options for sensors, setups, and 
jobs. These menu items are available only by right-clicking the name of the item in the 
Tree View. 

The Tree View functions much like the Windows Explorer. The main level shows Sensors, 
Setups, and Jobs; if a job or a setup doesn't exist in a particular data file, these main items 
will not appear in the Tree View. 
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The main-level items have a plus sign (+) next to them if they are collapsed to the first level. 
When the main-level items are expanded, a minus sign (-) appears next to the item. 

1. Click the plus sign to expand an item. Click the minus sign to collapse the item. 

2. To widen the Tree View pane, place your cursor over the dividing border until the cursor 
turns into a standard Windows two-headed arrow. Click and hold on the border, then drag 
the border to the right. Release the mouse button when you are satisfied with the width of 
the Tree View. 

3. To narrow the Tree View pane, drag the dividing border to the left. 

4. To resize the entire AvTrend window, click and hold on any of its borders or lower 
corners and drag in the direction you wish to resize the window. 

��!���!���!���!������"���� �����#������"���� �����#������"���� �����#������"���� �����#���������

With the AvTrend Viewer, you can view sensor specifications; setups for propeller, rotor, and 
vibration survey jobs; and the job data themselves. To view an item, click its name in the 
Tree View. The data that appear in the Data Viewing Area depend on the type of item you 
have selected to view. 

 

Figure 3: Data Viewing Area (right pane of AvTrend window). Sensors, setups, and jobs other 
than vibration surveys appear as text; vibration surveys are shown in graphs on the Surveys 
tab and setup information is shown on the Info tab. 
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1.4.1 - Sensors 

The sensors are piezoelectric sensors used to detect vibration during an analysis. The 
configurations for those sensors are stored in the ACES analyzer and can be downloaded into 
AvTrend. The sensor configurations show the type of sensor, its sensitivity units, and its 
polarity. See the ACES analyzer user manual for more information on sensors. 

1.4.2 - Setups 

Setups are the parameters for the particular test you will run. Generally, the setups specify the 
type and number of engines (if applicable); information about the rotor(s) (if applicable); and 
other data addressing the forces to be measured and setting certain limits and units of 
measurement. 

1.4.3 - Jobs 

When you view a propeller or rotor job in the Data Viewing Area, you see its setup 
information as well as any suggestions regarding balancing the rotors or propellers. When 
you view a vibration survey, you see its spectrum (or two spectra if two sensors were used) 
on the Surveys tab and its setup information on the Info tab. See “Viewing Spectra in the 
AvTrend Viewer” for more information about vibration spectra. 

��$���$���$���$������ �����#�%�����������&��"���� �����#������ �����#�%�����������&��"���� �����#������ �����#�%�����������&��"���� �����#������ �����#�%�����������&��"���� �����#���������

This topic overviews how to use the Data Viewing Area to view a spectrum. See “How to 
Read a Spectrum” for more information. 

1.5.1 - Surveys Tab 

The Surveys tab shows the vibration spectrum collected during the job. If you collected data 
on one channel only, only one spectrum will appear in the Data Viewing Area. If you 
collected data on two channels, both spectra will show at one time in the Data Viewing Area. 

• The gray area of the window displays information about the component the survey was 
performed on, including the date and other job-specific information. 

• The condition box shows the condition(s) you specified in the setup and allows you to 
display the spectra associated with each condition. 

NOTE 
The ACES analyzer allows you to specify up to ten separate conditions. When you 
are viewing spectra, you may click the drop-down arrow beside the Condition text 
field to select among the various conditions. The spectrum associated with that 
condition will appear in the Data Viewing Area. 

• OVR (“overall”) displays the sum of all amplitude peaks collected over the specified 
bandwidth for the survey. This, in turn, indicates the total energy measured during a 
single survey. OVR units are the same as those specified for the Y axis.  
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NOTE 
You WILL NOT see an OVR value when you have done a peak hold vibration 
survey. In that type of survey, where the peak values are “smeared” over the 
bandwidth, OVR values would be meaningless information. 

• The small box just beneath OVR, which is the X-Y coordinate window, always shows the 
exact coordinates of your cursor location. 

• The center heading on the spectrum – “Left” on this example spectrum – indicates the 
descriptor for the channel, as specified in the setup. 

• The X axis units are RPMs or Hertz (Hz), depending on the units specified in the setup. 
The highest number on the X axis reflects the highest frequency collected during the 
survey. You may zoom in (decrease) or zoom out (increase) on data points on the X axis. 

• The Y axis shows the engineering units of amplitude specified during setup (usually 
recommended by the manufacturer). The highest value in the Y axis (in the default view) 
reflects the FSR (Full Scale Range) specified in the setup. You may zoom in (decrease) 
or zoom out (increase) on data points on the Y axis. 

NOTE 
If your vibration survey consists of two spectra, both spectra will increase or 
decrease on the X or Y axis by the same amount when you execute the Increase or 
Decrease command. 

1.5.2 - Info Tab 

The Info tab shows job information, Analyzer information, and setup information for the 
specific vibration survey (other job types display as text and contain their setup information 
in the same view). When you print a survey, AvTrend prints both the spectra from the 
Surveys Tab and the setup data from the Info Tab. 
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These instructions provide an overview on reading a spectrum in AvTrend. These instructions 
ARE NOT intended to help you interpret what you see in the spectrum and do not cover all 
cases. 

CAUTION 
Always consult the appropriate engineer if you are unsure how to interpret peaks or if 
you need help with identifying unknown peaks. 

NOTE 
Spectra will differ according to the aircraft, engine, or component from which you are 
collecting data. IN ALL CASES, if directives are available from the manufacturer, you 
MUST adhere to them for data collection and analysis. 
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1.6.1 - Characteristics of a Spectrum 

The ACES analyzer detects (within the capabilities of the analyzer and the accessories used 
to collect data) the vibration of components across a range of frequencies, which is specified 
in the setup for the survey. 

Typically, those components with the largest mass – such as the propeller or fan – create the 
largest amount of vibration. They therefore will typically show up as the largest peaks on the 
vibration survey. Other components with smaller mass show up as smaller peaks. 

NOTE 
The vibration characteristics of the components vary according to the mechanical 
condition, alignment, temperature, mass, and rotational speed of the component, to 
name just a few conditions. You MUST have a reference speed in order to positively 
identify individual components. 

See “Identifying Unknown Peaks” for additional information. 

1.6.2 - Reading the Spectrum 

NOTE 
This is a fictitious example spectrum. It does not indicate normal operating speeds of 
actual components. 

After you collect the vibration survey data according to manufacturer instructions, download 
the file to AvTrend and open the spectrum in the Data Viewing Area. 

 

Figure 4: Fictitious spectra with peak labels added. 

1. In the X-Y Plot (the spectrum), you can see the frequency in RPMs along the horizontal 
(X) axis. (Depending on the setup of the survey, this scale also could be in Hertz (Hz) or 
cycles per second.) 
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2. On the spectrum, locate the frequency of interest on the X axis. 

3. Use your cursor and (if needed) the peak labels to determine the amplitude (on the Y 
axis) of that frequency. 

4. Check the amplitude (on the Y axis) of that peak against the manufacturer's 
specifications. 

NOTE 
The highest peak on a spectrum should represent the component with the largest 
mass (such as the fan or propeller, for example). 

5. Next, find the peaks that represent other components in the system according to the 
manufacturer's specifications. You can compute exact frequencies using the following 
formula: 

drive speed * turning ratio of the component 

6. Compare these values on the Y axis with the units published by the manufacturer, noting 
whether the vibration amplitudes at specified frequencies are within the specified range 
or out of range. 

7. Follow the manufacturer's instructions for any necessary actions. 

1.6.3 - Identifying Unknown Peaks 

CAUTION 
Always consult the appropriate engineer if you are unsure how to interpret peaks or if 
you need help with identifying unknown peaks. 

NOTE 
Spectra will differ according to the aircraft, engine, or component from which you are 
collecting data. IN ALL CASES, if directives are available from the manufacturer, you 
MUST adhere to them for data collection and analysis. 

At times, you may see peaks in your spectrum that don't correspond to the vibration sources 
you are examining. In those cases, AvTrend provides tools to help you identify these 
unknown peaks. 

1. Using your cursor and/or peak labels, find the amplitude and frequency of the peak 
whose source you cannot identify. 

2. Consult the manufacturer's specifications or maintenance manual to rule out the 
possibility that the peak is some slight variation of a known vibration source. 

3. Place your cursor on the largest peak, then turn on the harmonic cursors. This may help 
you identify whether the peak is a harmonic of the fundamental (the peak on which you 
placed your cursor). 



ACES AvTrend Bronze ��������	�
�

� General Topics in AvTrend – 1-13 

 

Figure 5: Fictitious spectra; the fundamental frequency is the farthest-left cursor; 
harmonic cursors indicate multiples of the fundamental frequency. 

NOTE 
These are fictitious example spectra. They do not indicate normal operating 
speeds of actual components. 

4. Leaving the harmonic cursors on, place your fundamental cursor in turn on the peaks for 
the other known vibration sources to identify whether the unknown peak is a harmonic. 

5. If you have ruled out ALL the above possibilities, the unknown peak could indicate other 
problems such as a spalled bearing or a damaged bearing race. Consult the appropriate 
engineer for guidance. 
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When you use AvTrend to download data files from an ACES analyzer to your PC, AvTrend 
gives the data file a unique name (which contains letters and numbers) and stores the 
downloaded file in a subdirectory whose name matches the serial number of the ACES 
analyzer. This subdirectory is located inside the main AvTrend directory. AvTrend then uses 
that name to find the data file when you execute the File | Open | By Download command. 

In general, if you wish to view them in the AvTrend file browser (see Figure 6 below) you 
should avoid renaming the data files. If you rename the data files inside the main AvTrend 
directory, AvTrend will no longer “see” the file when you select File | Open | By Download. 
If you need to rename files for administrative purposes, you must use the File | Open | By 
Filename command to find and open the renamed files. 



 

1-14 – General Topics in AvTrend �����

 

Figure 6: AvTrend file browser, accessed by selecting File | Open | By Download. 
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When you download a data file from the ACES analyzer, the data file can contain many 
different jobs, setups, and sensors. Many times, these items are unrelated to each other. You 
can use AvTrend's export feature to export items into their own data or setup file, then merge 
related files into those exported files. 

1. Select the item you wish to export into its own data file by clicking one time on its name 
in the Tree View. 

2. Right-click on the item's name and select Export | Data File. 

3. AvTrend generates the Save As dialog box, which specifies ACES database file as the 
data type. Give the new file a unique name that will allow you to identify it by customer 
or by job (or any other appropriate identifier) and click the Save button. 

4. Select the second item you wish to export into the new data file, right-click on its name, 
and select Export | Data File. 

5. When AvTrend generates the Save As dialog box, browse to and click on the name of the 
data file you created in Step 3. AvTrend enters that name into the File Name text area. 
Click the OK button. 

6. AvTrend generates a warning dialog box with three options: Merge, Overwrite, or 
Cancel. 



ACES AvTrend Bronze ��������	�
�

� General Topics in AvTrend – 1-15 

 

Figure 7: Overwrite/Merge dialog box. 

7. Click the Merge button to merge the data file into the newly created data file. 

8. Click the Overwrite button to replace the existing data file with the new data file. 

9. Click the Cancel button to abort the export command. 

10. Select File | Open | By Filename and browse to locate the merged data file. The new file 
should contain each item you exported into it. If the item you exported was a job, you 
should also see the associated setup for that job. 
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The File menu allows you to open and close data files, download data from the ACES 
analyzer, send setups to the analyzer, and print files. The File menu also has a standard 
Windows recent files list, which allows you access to the most recently opened data files. 

 

 

 

Figure 8: File menu with empty spectra showing in the Data Viewing Area. 
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File | Open gives you the option to open a data file stored anywhere on your hard drive or 
removable disk (Open by Filename), or to open a data file stored inside the AvTrend main 
directory. 

 

Figure 9: File | Open submenu. 

2.1.1 - Open By Filename 

File | Open | By Filename allows you to browse anywhere on your hard drive or other storage 
device and find an ACES Data File or an ACES Setup File. 

 

Figure 10: File | Open | By Filename dialog box. 
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1. Select File | Open | By Filename. AvTrend launches the Open Database dialog box and 
specifies files of type ACES 2020 DataBase File. 

2. Browse until you locate the data file you wish to open. Click its title, then click the Open 
button, or double-click its name. AvTrend opens the data file in the AvTrend viewer. 

2.1.2 - Open By Download 

File | Open | By Download takes you directly to the AvTrend file browser, which allows you 
to browse all the data files downloaded from an ACES analyzer into AvTrend. 

 

Figure 11: File | Open | By Download dialog box. 

File | Open | By Download displays the AvTrend file browser (Open Exported Database). The 
Tree View shows directories named after the serial numbers of the analyzers from which you 
have downloaded data files. When you click on one of the directories in Tree View, the data 
files in the directory appear in the Data Viewing Area. The file browser also indicates the 
database date, backup date, and modified date; you may need to scroll horizontally to see this 
additional information. 

1. Select the directory containing the data file you wish to open by clicking on its folder 
icon one time. 

2. If the directory contains more than one data file, click one time on the name of the data 
file to select it and click the Open button; or double-click the name of the data file. 
AvTrend opens the data file in the AvTrend viewer. 

NOTE 
After you download a data file from the ACES analyzer, the file acquires a unique 
name that combines several identifying features of the file. This file name, 
however, may not be recognizable as representing the analyzer or date of 
download. 

CAUTION 
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You may rename the file by selecting the title and using the Windows rename 
feature, but it will not then show up in the AvTrend file browser, even if it remains 
in the same directory as the other downloaded data files. AvTrend will NOT be able 
to open that file by download. If you have renamed your data file, you must use the 
Open by Filename command to open the data file in AvTrend. 

���������������������0
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���0

���0

������

File | Close closes the currently open data file. It does not generate a dialog box. 

���������������������1����%��	���1����%��	���1����%��	���1����%��	������

Setups are the parameters you establish for any test you run with the ACES analyzer. Each 
data file you download from an Analyzer contains setups specific to the jobs in that data file. 

AvTrend maintains a database, the Setup Library, in which you may store all the setups you 
download from any analyzer. Any time you send a setup to this Setup Library, AvTrend scans 
the setup for any new sensors and includes those in the Sensors section of the setup library as 
well. 

The File | Edit Setups command allows you to open the Setup Library (filename: setup.asf; 
file title: Setup Database), view sensors and setups, delete sensors and setups, and export 
them as setup files (*.asf) or text files (*.txt). 

 

Figure 12: File | Edit Setups dialog box. A propeller setup highlighted in Tree View is showing 
in Data Viewing Area. 

NOTE 
In AvTrend Bronze, the term “edit” refers only to viewing, exporting, or deleting 
existing setups. You cannot create a new setup or modify an existing setup in AvTrend 
Bronze; you must use an ACES analyzer for those tasks. (AvTrend Silver allows you to 
both create new and modify existing setups.) 

1. Select File | Edit Setups. AvTrend closes any currently open data file and opens the Setup 
Library. 
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2. To delete a setup from the Setup Library, select its title in the Tree View and press the 
Delete key. AvTrend immediately deletes it without generating a dialog box. 

3. If you accidentally delete a setup you wish to keep, you may use the Add to Setup 
command to replace it in the Setup Library. 

2.3.1 - Exporting a Sensor or a Setup from the Setup Library into a Setup 
File 

This procedure explains how to export sensors and/or setups from the Setup Library into a 
separate setup file. 

NOTE 
The process for exporting sensors and setups from the library is similar to the 
procedure for exporting data files. 

1. Select the sensor or setup by clicking one time on its name in the Tree View. 

2. Right-click on the item’s name to access the shortcut menu. 

 

Figure 13: Export Setups submenu (used to export setups and sensors from Setup 
Library); setup highlighted in Tree View is showing in Data Viewing Area 

3. Select Export, then select Setup File from the shortcut menu. AvTrend generates the Save 
As dialog box; the Save as type text field indicates AvTrend will save the file as an 
ACES Setup File. 
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Figure 14: Dialog box generated when you select Export | Setup File from the Setup 
Library. 

4. Give the file a name, browse to the directory where you wish to store the data file, and 
click the Save button. AvTrend exports the selected sensor or setup to an ACES Setup 
File, which you can then open with AvTrend or send to an ACES analyzer. 

5. Click the Cancel button to abort the export command and dismiss the Save As dialog box. 

2.3.2 - Exporting a Sensor or Setup from the Setup Library as a Text File 

This procedure explains how to export sensors or setups from the Setup Library to a separate 
text file. 

1. Select the sensor by clicking one time on its name in the Tree View. 

2. Right-click on the sensor name to access the shortcut menu. 

 

Figure 15: Export Setups submenu (used to export setups and sensors from Setup 
Library); setup highlighted in Tree View is showing in Data Viewing Area 
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3. Select Export, then select Text. AvTrend generates the Save As dialog box; the Save as 
type text field indicates AvTrend will save the file as text only. 

 

Figure 16: Dialog box generated when you export a sensor or setup from the Setup 
Library as a text file 

4. Give the file a name, browse to the directory where you wish to store the text file, and 
click the Save button. AvTrend saves the selected sensor as text only, which you can then 
open with Notepad or WordPad. 

5. To abort any export command and dismiss the Save As dialog box, click the Cancel 
button. 
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2.4.1 - Retrieve Data 

File | Transfer | Retrieve Data allows you to download data files from the ACES analyzer into 
AvTrend for viewing, printing, and exporting. 

1. Attach the ACES analyzer to your computer using the serial cable (see your analyzer 
Owner's Manual for more instructions). 

2. Turn on the ACES analyzer. 

NOTE: 
If your PC doesn’t recognize the analyzer when you try to transfer data, power 
down the computer before attaching the analyzer. 

3. When the analyzer powers up and displays the Main Menu, arrow down and select 
“Transfer Data with PC” (the command is selected when the background of the command 
is dark and the letters are white). Press the Enter key on the analyzer. You will see a 
message in the Analyzer window, “Transferring data with Host.” 
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4. In AvTrend, select File | Transfer | Retrieve Data. 

5. If the database doesn't already exist in AvTrend, the download begins. In the AvTrend 
toolbar, a status bar indicates the percentage of the download that is complete and the 
“lights” to the left of the status bar glow red and green in succession. 

6. In the Data Viewing Area, AvTrend generates a report (non-printable and cannot be 
saved) indicating the following: 

• Attempts to communicate with the analyzer 

• Boot ROM version 

• Analyzer serial number 

• Negotiated baud rate 

• Information about transfer of the database 

 

Figure 17: Retrieving data from an ACES analyzer using File | Transfer | Retrieve Data. 

7. When the download is complete, AvTrend briefly reports on the success of the download, 
then the report disappears and AvTrend opens the newly downloaded database. 

8. If the database has already been downloaded, AvTrend indicates that the database already 
exists and terminates the download 
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Figure 18: Report AvTrend generates if you attempt to download a duplicate data file 
(one that’s already been downloaded and is unchanged). 

2.4.2 - Send Setups 

File | Transfer | Send Setups allows you to upload setups from AvTrend to the ACES 
analyzer. 

NOTE 
Although you cannot create or edit the parameters of setups in AvTrend Bronze, you 
can receive setups from remote areas, other organizations, or the factory, for example, 
and upload those setups to your ACES analyzer(s). 

1. Attach the ACES analyzer to your computer using the serial cable (see the Model 2020 
Owner's Manual for more instructions). 

2. Turn on the ACES analyzer. 

NOTE: 
If your PC doesn’t recognize the analyzer when you try to transfer data, power 
down the computer before attaching the analyzer. 

3. When the Analyzer powers up and takes you to the Main Menu, arrow down and select 
“Transfer Data with PC” (the command is selected when the background of the command 
is dark and the letters are white). Press the Enter key on the Analyzer. You will see a 
message in the Analyzer window, “Transferring data with Host.” 

4. In AvTrend, select File | Transfer | Send Setups. 

5. AvTrend begins the process of uploading the all the setups that currently reside in your 
“setup.asf” file (Setup Library). In the AvTrend toolbar, a status bar indicates the 
percentage of the download that is complete and the “lights” to the left of the status bar 
glow red and green in succession. 



 

2-10 – File Menu �����

6. In the Data Viewing Area, AvTrend generates a report (non-printable and cannot be 
saved) indicating the following: 

• Attempts to communicate with the Analyzer 

• Boot ROM version 

• Analyzer serial number 

• Negotiated baud rate 

• Information about transfer of the setup file 

 

Figure 19: Sending setups and/or sensors to an ACES analyzer. 

7. When the upload is complete, the report indicates the transfer is complete. 
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This area of the File menu lists the most recently opened data files. You may use this list to 
move among recently opened files without executing the File | Close, then File | Open 
commands. 

When you select a data file from this list, AvTrend closes the currently open data file, without 
presenting a dialog box, and opens the newly selected data file. 
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File | Print generates the standard Windows Print dialog box. The options on the dialog box 
may vary according to the attached printer. With this command, you may print sensor data, 
setups, and jobs. When you print vibration spectra, AvTrend also prints the setup for that job. 
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1. With the information you wish to print showing in the Data Viewing Area (right pane), 
select File | Print or click the Print button on the toolbar. 

2. Click the Properties button to access the printer properties. 

3. Specify the page range and number of copies. 

NOTE 
Other options may exist, depending on the attached printer. 

4. Click the OK button to send the print job to the printer. Click the Cancel button to 
dismiss the Print dialog box. 
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File | Printer Setup generates the standard Print Setup dialog box, which varies according to 
the printer(s) you have attached to your system. From this dialog box, you can access the 
print setup properties, specify the paper size, source, and orientation. Other options may exist, 
depending on the attached printer. 

1. Select File | Printer Setup to access print setup properties. 

2. Depending on the attached printer, set advanced options for paper, graphics, and the 
device. 

3. Click the Properties button to access printer-specific settings and advanced properties. 
Click the OK button to accept your changes. 

4. At the main Printer Setup dialog box, click the OK button to accept your changes and 
return to the AvTrend main window. This does not send a job to the printer. Click the 
cancel button to dismiss the Print Setup dialog box. 
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File | Exit closes any currently open data file and closes AvTrend. It does not generate a 
dialog box. You may also exit by clicking the Close button (the X) in the upper right portion 
of the AvTrend title bar. 
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Chapter 3 
 �������	 �������	 �������	 �������	����

 

The View menu, which is available only when you have a vibration spectrum open in the 
Data Viewing Area, allows you to change the scale of the X and/or Y axes, restore both axes 
to the default scale, select a type and size for the spectrum cursor, turn the grids off or on, 
turn the harmonic cursors off or on, and add or remove peak labels. 

Items in the View menu are also available from a shortcut menu by right-clicking anywhere 
in the Data Viewing Area when you have a vibration spectrum open.  

 

Figure 20: View menu (available only if a spectrum is open in the Data Viewing Area). 
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To restore a spectrum to its default or normal scale (X and Y axis at the same time), select 
View | Default Scale, or right-click on the spectrum and select Default Scale. AvTrend 
restores both the X and Y axes to their original scales and does not generate a dialog box. 

NOTE 
If two spectra are showing in the Data Viewing Area, AvTrend restores the default 
scale for both spectra. 
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The highest number on the X axis reflects the highest frequency collected during the survey. 
Selecting View | X Axis – or right-clicking anywhere on an open spectrum – opens the X 
Axis submenu, which allows you to zoom out or zoom in on data points on the X axis; 
AvTrend does this by increasing or decreasing the scale of the X axis and “magnifying” the 
graph accordingly.  

  

Figure 21: X axis pull-down menu and right-click submenu. 

NOTE 
You may decrease the X axis from its default view, but you may not increase it from 
the default view because the data do not exist. The number of times you can decrease 
the X axis from the default scale depends on the lines of resolution specified in the 
setup and the placement of your cursor. AvTrend “hides” data points from both sides 
of the cursor when you decrease the X axis scale. 

1. Click on the vibration spectrum in the Data Viewing Area so it is the active portion of the 
window. 

2. Right-click on the spectrum – or select View | X Axis from the menu items – and select X 
Axis | Increase or X Axis | Decrease. The scale of the X axis increases (doubles each 
time) or decreases (halves each time). You may also use CTRL + Page Up/Page Down to 
increase/decrease the X axis. 
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NOTE 
If the vibration survey consists of two spectra, the X axis of each spectrum will 
change according to the specified increase or decrease; the X axis scales will 
always be the same at the leftmost and rightmost coordinate. 

NOTE 
AvTrend decreases the X axis relative to the cursor placement. Depending on 
where your cursor is when you execute the X Axis | Decrease command, AvTrend 
centers the decreased scale around the peak your cursor is on. The X-Y 
Coordinate Window on the graph indicates your location on the graph with each 
increase or decrease. See “Viewing Spectra in the AvTrend Viewer.” 

3. To restore to the “normal” (default) scale, select View | Default Scale, or right-click on 
the spectrum and select Default Scale. AvTrend returns the X axis to its default setting. 

NOTE 
The default scale is determined by the initial conditions and limits specified in the 
setup for the vibration survey. The setup is created in the ACES analyzer. 
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The highest value in the Y axis (in the default view) reflects the FSR (Full Scale Range) 
specified in the setup for the vibration survey. Selecting View | Y Axis – or right-clicking 
anywhere on an open spectrum – opens the Y Axis submenu, opens the Y Axis submenu, 
which allows you to zoom out or zoom in on data points on the Y axis; AvTrend does this by 
increasing or decreasing the scale of the Y axis and “magnifying” the graph accordingly. 

  

Figure 22: Y axis pull-down menu and right-click submenu. 

NOTE 
You can increase and decrease the Y axis over a range of 28 changes; if the FSR is 1, 
you can increase the scale 14 times and decrease the scale 14 times. If the FSR is 2, 
you can increase 13 times and decrease 15 times, and so on. 

1. Click on the vibration spectrum in the Data Viewing Area so it is the active portion of the 
window. 
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2. Right-click on the spectrum – or select View | Y Axis from the menu items – and select Y 
Axis | Increase or Y Axis | Decrease. The scale of the Y axis increases or decreases 
(doubles or halves) accordingly. You may also increase or decrease the scale with the 
Page Up/Page Down keys. 

NOTE 
If the vibration survey consists of two spectra, the Y axis of each spectrum will 
change according to the specified increase or decrease. AvTrend changes the Y 
axis without regard to the cursor placement. 

3. To return to the “normal” (default) scale , select View | Default Scale, or right-click on 
the spectrum and select Default Scale. AvTrend returns the Y axis to its default setting. 

NOTE 
The default scale is determined by the initial conditions and limits specified in the 
setup for the vibration survey. The setup is created in the ACES analyzer. 
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View | Cursor – or right-clicking on an open spectrum – generates the Cursor submenus, 
where you have an option to turn cursors off or on, change cursor types, and turn harmonic 
cursors off and on. 

  

Figure 23: Cursor menu and right-click submenu. 

3.4.1 - Cursor On, Cursor Off 

When you have a vibration survey spectrum showing in the Data Viewing Area, the cursor is 
on by default. 

1. Select View | Cursor | Off. The cursor disappears from the spectrum and Off is checked 
in the Cursor submenu. 

2. Select View | Cursor | On to turn the cursor on again. 
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3.4.2 - Harmonic Cursors 

View | Cursor | Harmonic toggles the harmonic cursors off and on. Use the harmonic cursors 
to identify multiples of the fundamental frequency of interest. 

1. Place the cursor on the frequency of interest. 

NOTE 
When you turn on the harmonic cursors, this becomes the fundamental frequency. 
You may move the fundamental frequency by using the arrow keys or the mouse. 
The cursor indicating the fundamental frequency is always the farthest left cursor 
on the X axis. 

2. Select View | Cursor | Harmonic. 

3. The harmonic cursors appear to the right of the fundamental frequency. The first 
harmonic cursor is two times the fundamental; the second is three times the fundamental, 
and so on. 

 

Figure 24: Spectrum showing the fundamental cursor (farthest left) and harmonic cursors; 
the harmonic cursors indicate all the peaks that are harmonics of the fundamental 
frequency. 

4. Use the mouse or arrow keys to move the cursors; the harmonic cursors maintain the 
relationship of 2x, 3x, and so on to the fundamental cursor. 

5. Select View | Cursor | Harmonic to turn the harmonic cursors off. 

NOTE 
If you place your fundamental cursor at a point on the X axis that exceeds fifty percent 
of the displayed bandwidth, the harmonic cursors will not be visible (the nearest 
harmonic is out of range to the right). The harmonic cursors give meaningful 
information only if the fundamental cursor is in the lower fifty percent of the X axis 
(visible frequency range). 
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For example, if your frequency bandwidth is 0 to 1000 Hz, and you are viewing the 
frequency range between 500 and 1000 Hz, your cursor must be placed at 750 Hz or 
lower in order to see the first harmonic cursor. If you are viewing the full frequency 
range specified in the setup (in this case, 0 to 1000 Hz), your cursor must be placed at 
500 Hz or lower in order to see the first harmonic cursor. 

3.4.3 - Cursor Type 

View | Cursor | Cursor Type allows you to specify the shape of the cursor you use to select 
data points along a spectrum. When you select this item, you may choose among the 
following cursors listed on the following submenu: 

 

Figure 25: Cursor type submenu; cursor style does not affect data being viewed 

When you select one of the cursors, a checkmark appears beside its name. The default cursor 
is Square Tick. The size and shape of the cursor is strictly for user convenience; the different 
cursors do not affect the data you are viewing. 

If you have difficulty seeing the cursor, maximize your spectrum window. If your window is 
not maximized, the cursor may appear to be too small, especially if your vibration survey 
contains two spectra. You may also select one of the larger cursors or change the color of the 
cursor to increase its contrast. 
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Grids are the horizontal and vertical tick marks on vibration spectra that help you locate the 
coordinates of a particular peak. You may both change the color of the grids and turn the 
grids off or on (which is default).NOTE 

See “Viewing Spectra in the AvTrend Viewer” for more information. 
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1. Select View | Grids. AvTrend generates the Grids submenu, which has two options: On 
and Off. If AvTrend is set to the defaults, On will have a checkmark beside it and the 
grids will be visible in the spectrum window. 

2. Select View | Grids | Off. The grids disappear from the spectrum, leaving only the peaks, 
cursor(s), and axes (and other information about the spectrum). 

 

Figure 26: Spectra windows with grids turned off. 

Select View | Grids | On. The grids reappear on the spectrum. 

 

Figure 27: Spectra windows with grids turned on. 
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When you are viewing a spectrum, you may add peak labels at any point on the spectrum, or 
at several points along the spectrum. These labels indicate the exact amplitude (Y axis) and 
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frequency (X axis) of that point on the spectrum. Any peak labels you add will print with the 
spectrum. 

 

Figure 28: Spectra with peak labels added. 

AvTrend maintains the labels while you are viewing a particular spectrum, but does not hold 
that information in memory. If you click on another spectrum in the data file then return to 
the spectrum on which you added peak labels, the labels will be gone. 

From the Peak Labels menu item, you may turn the peak labels on (default) or off. From the 
Peak Labels right-click menu, besides turning peak labels off and on, you may add, delete, 
and delete all peak labels from a spectrum. 

  

Figure 29: Peak labels pull-down menu (View | Peak Labels) on left, and right-click menu on 
right. 

1. To turn the peak labels on, right-click on the active spectrum window, or select View | 
Peak Labels and click On; click Off to turn the labels off. 

2. To add a peak label, left-click on a peak in the active spectrum window. 
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3. Right-click on that peak and select Peak Labels | Add. AvTrend adds a peak label to that 
peak and draws a vertical, red dashed line down the left border of the label to the X axis. 

NOTE 
The red line that extends from the top of the graph, through the left border of the 
peak label, and through the middle of the peak you labeled indicates where the 
peak crosses the X axis. 

4. To remove a single peak label, left-click on the peak to select it, right-click on the peak, 
then select Peak Labels | Delete. AvTrend removes the label and red line. 

5. To remove all peak labels from a spectrum, right-click on the active spectrum window 
and select Peak Labels | Delete All. AvTrend removes all peak labels. 
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The Options menu allows you to set the options for communicating with the ACES analyzer. 
It also allows you to specify colors for various AvTrend items. 

 

Figure 30: Options menu; spectrum open in Data Viewing Area 
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Options | Communications | 2020 generates the 2020 Serial Port Settings dialog box (in the 
Bronze version), which allows you to specify the COM port to which the ACES analyzer is 
attached and select a baud rate for data transfer. 

 

Figure 31: Options | Communications | 2020 dialog box. 

1. In the top text field (Port), select the COM port you have the Analyzer attached to. 

2. In the bottom text field (Speed), select the baud rate of your COM port. If AvTrend 
cannot communicate at that baud rate, it automatically negotiates a usable baud rate with 
the Analyzer. 

3. Click the OK button when you are done. 

4. Click the Cancel button to dismiss the 2020 Serial Port Settings dialog box and return to 
the AvTrend viewer. 
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Options | Colors allows you to change the colors of the following AvTrend features, or reset 
any changed colors back to the system default colors. 

1. Select Options | Colors. AvTrend generates the Change Color Settings dialog box. 

 

Figure 32: Change Color Settings dialog box. 
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2. At any time, click the Cancel button to dismiss the Change Color Settings dialog box and 
return to the AvTrend viewer. 

3. To select an item whose color you wish to change, click one time on the item's name and 
click the Change button. AvTrend generates the standard Windows Color dialog box. 

 

Figure 33: Windows Color dialog box (Options | Colors). 

4. Select a new color for the highlighted item from the available color chips. If you don't see 
a color you wish to use, click the Define Custom Colors button. Windows generates the 
extended Windows Color dialog box. 

 

Figure 34: Windows Custom Colors dialog box (Options | Colors, Define Custom Colors 
button). 
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5. Using the sliders, color chips, or other means, select a color for the highlighted item, then 
click the OK button. The color chip next to the item in the AvTrend Change Color 
Settings dialog box reflects the new color. 

6. To reset all colors to the AvTrend defaults, click the Defaults button. 
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When you have a data or setup file open in AvTrend, you may perform a number of tasks 
through submenus available in the Tree View only (no pull-down menu items duplicate these 
commands). With these submenus, you may add sensors and setups to the Setup Library, 
export sensors and setups as setup files or as text files, export jobs as data files or (except for 
vibration surveys) as text files, and export vibration surveys as CSV files. To access these 
submenus, highlight an item in Tree View, then right-click on that item. 
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From the Sensors submenu, you may add a sensor to the Setup Library, export a sensor from 
a data file to a new setup file, or export a sensor as text. 

5.1.1 - Adding a Sensor to the Setup Library 

This procedure explains how to add any or all sensors from a data file to your Setup Library. 

 

Figure 35: Sensors menu and submenu; sensor data are showing in the Data Viewing Area. 

1. Select the sensor by clicking one time on its name in the Tree View. 

2. Right-click on the sensor name to open its submenu. 

3. Click on Add to Setup. AvTrend briefly displays a dialog box informing you that it is 
merging the selected sensor into the Setup Library. 

4. If needed, select File | Edit Setups to verify the sensor you just added is now in the Setup 
Library. 

5.1.2 - Exporting a Sensor to a Separate Setup File 

You may export any sensor from a downloaded data file into its own setup file (*.asf) with 
this procedure. 

NOTE 
See “File Management in AvTrend” for more information on using the export features. 
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1. Select the sensor by clicking one time on its name in the Tree View. 

2. Right-click to open the sensor submenu (see Figure 35 above). 

3. Select Export, then select Setup File. AvTrend generates the Save As dialog box; the 
Save as type text field indicates AvTrend will save the file as an ACES Setup File. 

 

Figure 36: Save As dialog box generated when you export a sensor as a setup file 

4. Give the file a name, browse to the directory where you wish to store the setup file, and 
click the Save button. AvTrend exports the file to an ACES Setup File, which you can 
then open with AvTrend. 

5. Click the Cancel button to abort the export command and dismiss the Save As dialog box. 

5.1.3 - Exporting a Sensor to a Text File 

You may export a sensor from a downloaded data file to a new text file using this procedure. 

1. Select the sensor in the data file by clicking one time on its name in the Tree View. 

2. Right-click on the sensor name to open its submenu. 

3. Select Export, then select Text. AvTrend displays the Save As dialog box and indicates it 
will save the sensor as a text file. 
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Figure 37: Dialog box generated when you export a sensor as text. 

4. Click the Save button. AvTrend exports the selected sensor into a new text file, which 
you can then open with Notepad or WordPad. 

5. Click the Cancel button to dismiss the Save As dialog box and cancel the export 
command. 
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From the Setups submenu, you may add a setup to the Setup Library, export a setup from a 
data file to a new setup file, or export a setup as text. 

 

Figure 38: Setups menu and submenu; sensor data are showing in the Data Viewing Area. 
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5.2.1 - Adding a Setup to the Setup Library 

You may add any or all setups from a data file to your Setup Library with this procedure. 

1. Select the setup by clicking one time on its name in the Tree View. 

2. Right-click on the setup name to open its submenu. 

3. Click on Add to Setup. AvTrend briefly displays a dialog box informing you that it is 
merging the selected setup into the Setup Library. 

4. If needed, select File | Edit Setups to verify the setup you just added is now in the Setup 
Library. 

5.2.2 - Exporting a Setup to a Separate Setup File 

You may export any setup from a downloaded data file into its own setup file (*.asf) with this 
procedure. 

NOTE 
See “File Management in AvTrend” for more information on using the export features. 

1. To export a setup from a downloaded data file into its own data file (*.asf), select a setup 
by clicking one time on its name in the Tree View. 

2. Right-click to open the setup submenu. 

3. Select Export, then select Setup File. AvTrend generates the Save As dialog box; the 
Save as type text field indicates AvTrend will save the file as an ACES Setup File (see 
Figure 36 above). 

4. Give the file a name, browse to the directory where you wish to store the data file, and 
click the Save button. AvTrend exports the file to an ACES Setup File, which you can 
then open with AvTrend. 

5. Click the Cancel button to abort the export command and dismiss the Save As dialog box. 

5.2.3 - Exporting a Setup to a Text File 

You may export a setup from a downloaded data file to a new text file using this procedure. 

1. Select the setup by clicking one time on its name in the Tree View. 

2. Right-click on the setup name to open its submenu. 

3. Select Export, then select Text. AvTrend displays the Save As dialog box and indicates it 
will save the new data file as a text file (see Figure 37 above). 

4. Click the Save button. AvTrend exports the selected setup into a new text file, which you 
can then open with Notepad or WordPad. 
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5. Click the Cancel button to dismiss the Save As dialog box and cancel the export 
command. 
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From the Jobs submenu, you may export a propeller, rotor, or vibration survey from a data 
file to a new data file; export a propeller or rotor job as a text file; or export a vibration 
survey to a CSV file. 

  

Figure 39: Export jobs and export vibration surveys submenus. A propeller job is open in the 
left-hand picture and a vibration survey is open in the right-hand picture. 

5.3.1 - Exporting a Job to a New Data File 

NOTE 
This procedure applies to all types of jobs, including vibration surveys. 

You may export a propeller, rotor, or vibration survey job from a downloaded data file into 
its own data file (*.adf) with this procedure. If you export a vibration survey, AvTrend 
exports its associated setup at the same time. 

NOTE 
See “File Management in AvTrend” for more information on using the export features. 

1. Select the propeller, rotor, or vibration survey job by clicking one time on its name in the 
Tree View. 

2. Right-click on the job name to open the jobs submenu. Note that the submenu for 
vibration surveys will be slightly different, but will still have the option to export to a 
data file. 

3. Select Export, then select Data File. AvTrend displays the Save As dialog box and 
indicates it will save the selected item as an ACES Database File. 
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Figure 40: Dialog box generated when you export a job as a data file. 

4. Click the Save button to export the job. AvTrend exports the selected job into its own 
data file, which you can then open with AvTrend. 

5. Click the Cancel button to dismiss the Save As dialog box and cancel the export 
command. 

5.3.2 - Exporting a Job to a Text File 

You may export a propeller or rotor job from a downloaded data file to a new text file using 
this procedure. 

NOTE 
This procedure applies to propeller or rotor jobs. Since vibration surveys must be 
exported as comma-separated text, that topic is covered separately. 

1. Select the propeller or rotor job by clicking one time on its name in the Tree View. 

2. Right-click on the job name to open the jobs submenu. 

3. Select Export, then select Text. AvTrend displays the Save As dialog box and indicates it 
will save the selected item as a text file (see Figure 37 above). 

4. Click the Save button to export the job. AvTrend exports the selected job into a new text 
file, which you can then open with Notepad or WordPad. 

5. Click the Cancel button to dismiss the Save As dialog box and cancel the export 
command. 

5.3.3 - Exporting a Vibration Survey to CSV 

You may export any vibration survey spectrum — along with its associated setup information 
— from a downloaded data file into its own data file (*.adf) with this procedure. 
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NOTE 
See “File Management in AvTrend” for more information on using the export features. 

1. Select the vibration survey by clicking one time on its name in the Tree View. 

2. Right-click to open the vibration survey submenu. 

3. Select Export, then select CSV. AvTrend generates the Save As dialog box and indicates 
it will save the file as a Comma Separated File. 

 

Figure 41: Dialog box generated when you export a vibration survey as a CSV (comma-
separated) file. 

4. Give the file a name, browse to the directory where you wish to store the data file, and 
click the Save button. AvTrend exports the file into a CSV File, which you can then 
import into a spreadsheet. 

5. Click the Cancel button to abandon the export command and dismiss the Save As dialog 
box. 
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The Help menu gives you access to the online help files for AvTrend, where you can search 
for help by topic or keyword. 

 

Figure 42: AvTrend Help menu. 
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Help | Contents and Index or Help | Search for Help On opens a standard Windows Help 
dialog box. 

 

Figure 43: Dialog box for AvTrend online help files. 

1. Click the Contents tab to search for help by topic. 

2. Click the Index tab to search by keyword(s). 

3. Click the Find tab to perform a more extensive search by keywords or phrases. 

See your Windows User Manual for more information on using help files. 
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Help | About gives you information about the currently installed version of AvTrend and, if 
applicable, when any temporary licenses expire. 

 

Figure 44: About dialog box for AvTrend Bronze. 
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Help | Licenses displays all currently active licenses for AvTrend. 


